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Introduction

The following guide is intended to guide the user in how to install, uninstall, load and

unload Netop on Linux.
Netop for Linux includes the Guest and Host.

The Guest can connect to a remote Host through the following communication
protocols:

e Netop Portal
e Internet (TCP)
e LAN (TCP)

The Host uses the following communication protocols to connect to the Guest:

e Netop Portal

e Internet (TCP)
e LAN (TCP)

e UDP

e HTTP

Install

Before you install the Host and Guest, make sure that your computer meets the

following minimum technical requirements:

Supported platforms: 32 & 64-bit

e Red Hat Enterprise Linux 7
e Ubuntu 16.04, 18.04, 20.04
e SUSE12

NOTE: Supported X Window System is X.org

Memory:


x.org
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e For the Guest a minimum of 1 GB (2 GB recommended)

e Forthe Host a minimum of 512 MB (1 GB recommended)
Disk space:

e For the Guest a minimum of 410 MB

e For the Host a minimum of 45 MB

Video: any supported by X.org Server

NOTE: To be able to install the Host or Guest, make sure that the user logged on the
computer has system user privileges.

To download the Netop for the supported Linux distributions refer to the following

link.

e The download page includes separate installation or archive files for the Guest and
Host depending on your Linux distribution.
e The archive file contains the following files:
o ca-certificates.crt
o eula.txt
o install.pl
o installpubkey
0 netop.pub

0 netop-*.deb | netop-*.rpm (based on the Linux distribution in use)
install.pl is aPerl script file that handles the installation process via the terminal.

To list all the parameters of the install.pl Perl script, use the following command:

install.pl --help

install.pl parameters table:

Function Command
[--help] Prints the help message and exits.



x.org
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[--version] Prints the version info and exits.

[--serial Installs the Guest | Host with the <serial> number license

<serial>] key.

[--debug] Turns debugging on.

[--license] Prints the License.

[--autoinstall] | Non-interactive installation assumes that you agree with the
License.

Example:
For the non-interactive Host installations, use the following command:

perl install.pl --autoinstall --host <serial>
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You can install the Guest and Host in two ways:
A. You double-click on the netop-host *.deb | rpm, and netop-
guest *.deb | rpminstallation file within your desktop environment.

B. Install them from the terminal.

NOTE: We recommend that you install the Guest and Host via the terminal.

Download the Guest

You can download the Guest from:
e the Portal

o the Netop website, by clicking on the following link

To download the Guest (Support Console) application from the Portal, proceed as
follows:

1. Login the Portal.

2. Go to the My Devices page.

1 MY DEVICES 2 Contact Neto

All Devices <[> Download Guest (Support Console) v | | Add device v |

Devices: Online % | Clear allthe fiters
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3. Click on the Download Guest (Support Console) button.

] my DEVICES £ Contact Netop ' Purchase Users: 48 /1000 OnDemand users: 5/5 Devices: 24 /300 v
Dashboard All Devices <[> Download Guest (Support Console) v | Add device v

My devices searchin: (@ Al fields Hostname Alias Operating system Logged in user

My sessions

My mobike devices -
# Hostname Status. Alias Group A\ Logged in user

® = Remote control . tr ® [J DESKTOP-6QQAFHV ®  Online for about 187 days DESKTOP-6Q0RFHV
jsers.

Devices

Group:

Appiications
Roles
Role assignments

Downloads

Account security
@, Authentication

B Logs

4. Select the desired platform from the dropdown menu.

neror
B8 Remote control [_1 My DEVICES © ContactNetop = Purchase Users: 4871000  OnDemandusers:5/5  Devices: 24/300 -

Dashboard All Devices <> Download Guest (Support Console) a Add device
. Online % | Clear all Windows
My sessions
& macos
My devices searchin: () Al fields Hostname Riias Operating system Logged in user .
) RedHat Enterprise 7.x/ CentOS 7.x
My mobile devices
J 4 Hostname Status Alias A Ubuntu 16.04/16.04 0 user
A SUSE Enterprise 12.x
=1 Remote control ‘ $7 @ [J DESKTOP-6QQAFHV = Online for about 187 days DESKTOP-6Q0AFHV
Users

Devices
Groups
Applications
Roles

Role assignmenis

Downloads

Account security
@, Authentication

B Logs

%€ Configuration

5. Save the archive.
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Install the Guest

A. Install the Guest through the Software Install”

To install the Guest through the application software, proceed as follows:

1. Go to the file path of the extracted Guest.

2. Double click on the netop-guest *.deb |rpm installation file. The following
window is displayed.

netop-guest
7 Netop Guest

A

ever

3. To install the Guest, click on the Install button.

4. Specify your password for authentication.
B. Install the Guest via the terminal”

To install the Guest via the terminal, proceed as follows:

1. Go to the file path of the extracted Guest.

2. Open up a terminal window.

3. Use the following Perl script to initiate the installation process:

sudo perl install.pl

Y

john@john-VirtualBox: ~/Downloads/wetransfer-ab5ac7/netop-guest-12.81-ubuntu-32bit

File Edit View Search Terminal Help

john@john-VirtualBox:~/Downloads/wetransfer-ab5ac7/netop-guest-12.81-ubuntu-32bi
tS sudo perl install.pl

Specify the password for authentication.

* The procedure applies to Ubuntu version 18.04.1 distribution of Linux.
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As part of the installation process, it is necessary that you accept the End User

License Agreement.

Jjohn@john-VirtualBox: ~/Downloads/wetransfer-ab5ac7/netop-guest-12.81-ubuntu-32bit

File Edit View Search Terminal Help

nd use anonymous technical data and related information, including but not limit
ed to technical information about Your devic

e, system and application software, and peripherals, that is gathered periodical
ly to facilitate the provision of software updates, product support and other se
rvices to You (if any) related to the Licens

ed software. Netop Business Solutiens may use this informatien, as leong as it is
in a form that does not personally identify You, to improve its products or to
provide services or technologies teo You.

16. Contact Information. Should you have any questions, complaints or claims wit
h respect to the Agreement, please contact us at Netop Business Solutions A/S,
regnerodvej 127, DK-3460 Birkerod, Denmark o

r +45 4590 25 25 or info@netop.com.

11. Vendor signing. For the Android version of Netop Mobile and Embedded it is e
xplicitly prohibited for end-users or any other to vendor sign or cause vendor s
igning of this module and thereby enabling t

his module to reach necessary system resources needed for the viewing of the scr
een and injection of input to the devices, that it otherwise could not reach. Do
ing so immediately revokes the license to us

e this module.

Do you accept this license ? [yes/No/quit] >yesl

Specify the type of license you want to use for the Guest. The following options are

available:

e Portal - all communication happens using the Portal (a Portal account is
required)

e Trial - a 15-day fully-featured trial

e Custom - specify the required license after buying the product

Activities [ Terminal ~ Lu 10:30 SO~
*s root@john-VirtualBox: ~/Downloads/wetransfer-ab5ac7/netop-guest-12.81-ubuntu-32bit™ & @
File Edit View Search Terminal Help

9. Consent to Use of Data. You agree that Netop Business Solutions may collect
and use anonymous technical data and related information, including but not 1im
ited to technical information about Your device, system and application softwar
e, and peripherals, that is gathered periodically to facilitate the provision o
f software updates, product support and other services to You (if any) related
to the Licensed Software. Netop Business Solutions may use this information, as
long as it is in a form that does not personally identify You, to improve its
products or to provide services or technologies to You.

10. Contact Information. Should you have any questions, complaints or claims wi
th respect to the Agreement, please contact us at Netop Business Solutions A/S,
Bregnerodvej 127, DK-3460 Birkerod, Denmark or +45 4590 25 25 or info@netop.co
m.

11. Vendor signing. For the Android version of Netop Mobile and Embedded it is
explicitly prohibited for end-users or any other to vendor sign or cause vendor
signing of this module and thereby enabling this module to reach necessary sys
tem resources needed for the viewing of the screen and injection of input to th
e devices, that it otherwise could not reach. Doing so immediately revokes the
license to use this module.

Do you accept this license ? [yes/No/fquit] =>YES

=
B
©)
=
A

[3] Which type of license do you want to use for Netop Guest? [T]rial / [plorta
1 / [c]ustom:
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Guest installed successfully.

Activities ] Terminal Lu 10:31 SO~

root@john-VirtualBox: ~/Downloads/wetransfer-ab5ac7/netop-guest-12.81-ubuntu-32bit! 0

File Edit View Search Terminal Help

11. Vendor signing. For the Android version of Netop Mobile and Embedded it is

explicitly prohibited for end-users or any other to vendor sign or cause vendor
signing of this module and thereby enabling this module to reach necessary sys

tem resources needed for the viewing of the screen and injection of input to th

e devices, that it otherwise could not reach. Doing so immediately revokes the

license to use this module.

Do you accept this license ? [yes/No/fquit] >YES

[3] Which type of license do you want to use for Netop Guest? [T]rial / [pJorta
1 / [c]ustom:

p
Please reply: [T]rial / [pJortal / [c]ustom

[3] Which type of license do you want to use for Netop Guest? [T]rial / [pJorta
1 / [clustom:

p
The license has been successfully set
Serial Number validated OK.
Netop Guest application has been installed and activated.
You can start the Netop Guest application by typing 'netopguest' as a regular u

ser.
Thank you for using Netop Solutions!

9
<
=
B
A
s"‘-?.\‘:
a

NOTE:
e You are prompted to specify a license key.

e If you do not specify a license key, Guest automatically installs itself in trial
mode.

Download the Host

You can download the Guest from:
e the Portal

e the Netop website, by clicking on the following link

10
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To download the Host application from the Portal, proceed as follows:

1. Login the Portal.

2. Go to the My Devices page.

8 =
Remote Control

1 my DEVICES

@& Dashboard

All Devices

B My sessions

My devices.

0 My mobile devices

® e B 7
[ Devices
B2 Groups

Applications

Roles

& Role assignments

B Downloads

@ Account security
@, Authentication

B Logs

#f Configuration

3. Click on the Add device button.

GRS | MY DEVICES

@& Dashboard All Devices

@ My sessions

Online X | Clear all the

@ Orline % | Clear all the

searchin: € Al fields

4 Hostname

7 ® [J DESKTOP-6QQAFHV

£ Contact Netop

Hostname () Alias

Hostname () Alias

Operating system

Operating system

= Purchase Users: 48 /1000 OnDemand use Devices: 24 /300

> Download Guest (Support Console) v Add device v

Logged in user

Status Alias, Group. ¥ Logged in user

Oniine for about 187 days DESKTOP-6Q0AFHV leii grei erist

£ contact Netop = Purchase Users: 48 /1000 ‘OnDemand use Devices: 24 /300

<> Download Guest (Support Gonsole) ¥ Add device ¥

Logged in user

;)
CJ My devices

0 My mobike devices

8 Users

[ Devices

80 Groups
Applications
Roles

& Role assignments

B Dovnloads

©® Account security
8, Authenication

B Logs

% Configuration

Netop
«

Searchin: (@ All fields

4 Hostname

[ = oo -]

¥r ® ) DESKTOP-6QQAFHV

Status

Online for about 187 days

Alias

DESKTOP-600AFHV

Group. T Logged in user

leii grei crist

11
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4. Select the Host for another operating system option from the dropdown menu.

] MY DEVICES

£ Contact Netop = Purchase 481000 v 5(5 e 24/300

@ Dashboard All Devices | 2> Download Guest (Support Cansole) v | Add device &

2 .
g My sessions

=M} dreican Searcnin @) Aifeits ) Hostname (| Alas () Operating system () Loggedin use

O My mobie devices

# Hostname v T Alias Group ¥ Loguedinuser

[— ® [ DESKTOP.SQQAFHY a DESKT
- u EEETER

[ Devices

BOOAFHY

85 Groups

(9 Applications

& Role assignments

Downloads

Account security

Authentication

5. Select the Host for the desired platform.

8 Remote Control DOWNLOADS

£ contact Netop ‘= Purchase Users: 48 /1000 OnDemand users: 5/5 Devices: 24 /300

4

@ Dashboard agent enroll

# Edit | | @ upload

| @ Revoke

o .
5 My sessions

Download installers

My devices
My mobile devices 18 Windows -
Users & macQS ’
1 Devices
4 Linux :
80 Groups

Download offline installer for
RedHat Enterprise 7.x / CentOS 7.x
- Ubuntu 16.04 / 18.04

SUSE Enterprise 12.x

Appiications

Role assignments

SECIE

Downloads

Send installer to another user

Account security

@ Copylink =7 Send link
Authentication
Package details
Name agent enroll
Configuration
Status ® Active
Description
Netop.
L Valid from 2020-10-06

6. Save the archive.
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Install the Host™

A. Install the Host via the Software Installer”

To install the Host via the Software Installer, proceed as follows:
1. Go to the file path of the extracted Host.
2. Double click on the netop-host *.deb | rpm installation file. The following

window is displayed.

3 Deben 101 4 e L  Ubunto 24,04 64-bit
-

(S )

0c

. netop-host

L lllllllllllllllll
2

@

H

2
o

3. To install the Host, click on the Install button.

4. Specify the password for authentication.

B. Install the Host via the terminal®

To install the Host via the terminal, proceed as follows:
1. Go to the file path of the extracted Host.
2. Open up a terminal window.

3. Use the following Perl script to initiate the installation process:

sudo perl install.pl

* The procedure applies to Ubuntu version 18.04.1 distribution of Linux.

* The procedure applies to Ubuntu version 18.04.1 distribution of Linux.
13
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4. Aspart of the installation process, it is necessary that you accept the Acceptable Use

Policy.

eriza@VM16: ~/Downloads

5. Specify the type of license you want to use for the Host. The following options are
available:
a. Portal - all communication happens using the Portal (a Portal account is
required)

i. Specify if you have a Portal account.

 Debian 10.x 64t 3 Red Hat Entesprise Lrux 7 64. + Ubuntu 24.04 64-bit

eriza@VM16: ~/Downloads

14
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ii. Specify the enrollment key for your Portal account.

 Debian 10.x 645t ¥ Red Hat Entespise Linux 7 64,  Ubuntu 24.04 64-bit

eriza@VM16: ~/Downloads

use for Netop Host? [T]rial / [plortal

use for Netop Host? [T]rial / [plorta

Enrollment key :

b. Trial - a 15-day fully-featured trial.
i. Specify if you have a Portal account.
ii. Specify the enrollment key for the Portal account.

c. Custom - specify the required license after buying the product.
i. Enter the License key for the Host.

NOTE:
¢ You are prompted to specify a license key.

e Ifyoudo notspecify alicense key, Host automatically installs itself in Trial
mode.

ii. Specify if you have a Portal account.
iii. Specify the enrollment key.

15
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Guest

Load and Unload the Guest

To load the Guest, execute the following command in a terminal window:

Netopguest

Netop Guest 6

File Connection Edit View Tools Help
J O AR Y e @t

[} Phonebook = Quick Connect | 4 Connections ] ¥ History

Host Communication Profile
TCP/IP Address:

[Ner.op Portal ]
[ v
Name (Optional, use with gateway):
«| Live Update

[ v

Connect ._‘J Browse || & Disconnect l LQ Connection Properties... ]
Hosts list

Host ID User Name Host UUID IP

\_Metop Network /\_Windows Network /

o
To unload the Guest, click on Exit from the File menu.

Netop Guest functionality

To connect to another port number than the Netop default port 6052, add the port
number to the Host name or address after a colon, for example, 192.168.100.1:1234.

16
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Host

Host includes the following programs:

e Netop Host Daemon (netophostd) - The Netop Host Daemon runs when the
computer operating system starts. A user with system user privileges can start and
stop the Netop Host Daemon.

e Netop Host Program (netophost) - The Netop Host Program loads and starts
when the Netop Host Daemon loads. If started, the communication is initialized
enabling a Netop Guest to connect. A user can typically control the Netop Host
Program from the Netop Host GUI.

e Netop Host GUI (netophostgui) - The Netop Host GUI displays the Netop Host
graphical user interface. It does not automatically load when the Netop Host

Program loads. A user can load and unload the Netop Host GUL.

NOTE: Only a user with system privileges can make changes to the Netop Host
program options.

Start and stop the Netop Host Daemon

The Netop Host Daemon starts and stops with the Linux operating system. A user with
system user privileges can start, stop and report the status of the Netop Host Daemon

with the following terminal window commands:

Command Function \ Description

/etc/init.d/netophostd start | Start You use this command to start
the Netop Host Daemon and
load the Netop Host Program.
/etc/init.d/netophostd Restart |You use this command to
restart restart the Netop Host
Daemon and load the Netop
Host Program.

/etc/init.d/netophostd Status You use this command to
status return a message of whether

17
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the Netop Host Daemon is
running or not.
/etc/init.d/netophostd stop |Stop You use this command to
unload the Netop Host
Program and stop the Netop
Host Daemon.

Display and hide the Netop Host window

The Netop Host GUI doesn’t automatically load when the Netop Host Program loads.
If the Netop Host Program is loaded, execute the following command in a terminal

window:

Netophostgui

The Netop Host interface is displayed.

Netop Host <

File VWiew Action Session Tools Help
> B
General | History @ Services = Communication = Names

Status
Running
Host ID

john-virtualBox

Host UUID

Address

192.168.201.6

o

NOTE: The Netophostgui command assumes that the Netop Host GUI program file is
located in the /usr/bin directory or is located in a directory included in the global
PATH. If the Netop Host GUI is located in another directory then specify the full
directory path before the Netophostgui command.

To unload the Netop Host GUI, click on Exit from the File menu.
18
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Host Functionality

The Host window contains most of the Host for Windows window elements but has
reduced functionality in comparison with the Windows version and the set up is

organized differently.

The Host enables a remote Guest to connect by using the TCP/IP, TCP/IP (TCP),
Serial (modem), HTTP, and the Netop Portal communication protocols. Once
authenticated, the Guest can view the remote screen, control the keyboard and mouse,

transfer files between the computers, and interact with the end-user.

To change the setup options of the Host, click on Options on the toolbar or from the

Tools menu. The Netop Host Configuration login window is displayed.

™ Netop Host Configuration - Login

Select account for changing configuration

Username root

Password

l oK | Cancel

Specify a valid Linux username and the matching password.

NOTE: To change the setup options, make sure that you have the privileges to edit the
/var/opt/Netop/host/host.xml file.

19
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Click on OK. The Netop Host Manager is displayed.

Netop Host Manager x

NetopHost Attribute “ Value
& Netophost
~ % Configuration
~ 7}, Local configuration
» £ Addresslists
- \;l Host computer
¢ %y Communication
+ [¥ General
b "6 Names
v @ Security
+ Help requests
+ Debug Log
+ Event Log
+ Tunnel Configuration
+ Host Monitor
* * Guest users
+ 2R security
MNetop Portal access rights
2 @ Roles
v [/ security server authentication
v 3L system authentication
J4 Netop authentication

ISEA( #1

Uninstall

Uninstall the Guest

To uninstall the Guest, either use the operating system'’s package or as root execute the

following commands in a terminal window:

e For RedHat, CentOS, SUSE:

rpm -e netop-guest

e For Ubuntu:

sudo apt autoremove Netop-guest

20
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Uninstall the Host

To uninstall the Host, either use the operating system’s package manager or as root
execute the following commands in a terminal window:

e For RedHat, CentOS, SUSE:
rpm - e Netop-host

e For Ubuntu:

sudo apt autoremove Netop-host

Refer to the specific package manager of your distribution that you are using for more

information on how to remove the installed packages.

21
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